
Part I: The CowTek HealthWatch System 

Overview 

The CowTek HealthWatch system uses an electronic ETD BOLUS (Elevated 
Temperature Detection bolus) to monitor cattle for infections or illnesses which cause 
loss in weight gain or milk production. The ETD BOLUS consists of a weighted 
capsule which rests in the animal’s rumen and incorporates temperature monitoring and 
recording circuitry together with a radio-frequency transmitter to report changes in 
internal temperature which may indicate illness or infection.  In addition to simple long-
term health monitoring, the HealthWatch system also offers special veterinary 
monitoring and fertility detection modes. 

Note: fertility detection is presently in development and is not offered as a 
reliable indicator. This feature is included, however, because it is being 
used in laboratory settings for further research. 

Also, because cattle are less thermally stable than some species and because their normal 
internal temperatures can vary with seasonal, climatic and regional conditions, the ETD 
BOLUS accepts threshold reporting levels which can be set either using the Desktop 
Exciter prior to implanting the bolus. 

Hardware Components: 

To manage and monitor report transmissions from the boluses and to control operational 
modes, in addition to the temperature boluses, the HealthWatch system includes three 
types of external device: a Desktop Exciter to initialize boluses and a Field Receiver to 
monitor cattle over a wide area. 

Temperature Bolus 

The ETD BOLUS is an active, battery-powered temperature monitoring device which 
records and tracks temperature changes. The bolus is designed to ignore minor 
temperature fluxuations caused by diet or exertion while reporting prolonged elevated 
temperatures which are indications of illnesses or infections which demand attention and 
treatment. 

 
Figure 1: The CowTek HealthWatch Temperature Bolus 



The ETD BOLUS is sealed in an inert polypropylene capsule and weighted to prevent 
the bolus from being expelled from the rumen or from being passed through the digestive 
system. Powered by a sealed lithium battery, the ETD BOLUS has a functional lifespan 
– without attention – of approximately five years. 

Because a cow’s normal temperature can vary according to the temperature of their 
environment, the ETD BOLUS monitors and calculates a ‘normal reference’ 
temperature for each animal, adjusting this reference temperature according to seasonal 
and climatic changes.  

In addition to long-term health monitoring, the ETD BOLUS can also be used for 
veterinarian monitoring to report reactions to injections, implants or other treatments and 
can be used for ovulation monitoring (in development) to report when an animal is ready 
for artificial (or natural) insemination following the use of fertility stimulants. 

NOTICE TO THE USER 

Any changes or modifications not expressly approved by CowTek, Inc for compliance 
could void your authority to use the equipment. 

FCC WARNING 

This device complies with part 15 of the FCC rules. Operation is subject to the following 
two conditions: (1) this device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation. 

Desktop Exciter 

The Desktop Exciter is used to ‘turn on’ a pill before it is given to the cow or bull.   

Because of FCC requirements for active transmitter devices and to ensure 
maximum battery life (estimated ~5 years), the HeathWatch temperature 
pills are shipped in a QUIET or OFF mode and must be initialized before 
use. 

The Desktop Exciter – see Figure 2 – has a recessed grove on the top shaped to the 
orientation of the pill; three mode buttons labeled WAKEUP, FERTILITY and VETERINARY 
and three threshold buttons labeled WINTER, NORMAL and SUMMER.  In addition there are 
two LEDs – one RED and one GREEN – which show operation and status; one serial port 
(DB9, RS232, not shown); and a power connection (not shown). 



 
Figure 2: The Desktop Exciter 

Components 

The Desktop Exciter includes a 12-volt power supply (120VAC to12VDC) and a serial 
cable for connections to a desktop computer. 

Field Receiver 

The Field Receiver consists of a control box and a pole-mounted antenna and is used to 
monitor and record messages transmitted by HealthWatch temperature pills in cattle 
over a wide area. The Field Receiver control panel does not provide switches to select 
operational modes or change temperature thresholds. 

 
Figure 4: The Field Receiver Control and Antenna 



The number and locations of Field Receivers necessary are determined by the area to be 
covered including such factors as the number of cattle, and the size and location of the 
pens or other enclosures being monitored. 

The Field Receiver control box has one LED pair (RED/GREEN) to report status 
information (see LED Indicators) and a set of four serial connectors, one power 
connection and one RF connector (see Ports and Connections). 

Note: the two DB9 connectors on the front of the Receiver control box 
(one male, one female) and the two DB9 connectors on the bottom (one 
male, one female) are all connected as a single serial port. The two types 
and two positions simply provide convenient connections for either a 
handheld (PDA) device or a desktop or laptop computer. 

Components 

The Field Receiver includes a 12-volt power supply (120VAC to 12VDC) and a coaxial 
cable (control panel to antenna unit).   

Optional components include: 

• PDA (handheld) to DB9 serial cable – required for handheld versions of 
HealthWatch Monitor and Commander programs. 

• DB9 Serial cable (M/F) – required for desktop/laptop connection to run 
HealthWatch Monitor and Commander programs. 

LED Indicators 

The Field Receiver has one LED pair (one red, one green) on the control box. 
Functionally, the LEDs are used for error and status reporting as: 

Error / Status Reporting 

LED Display Meaning Duration 

GREEN slow blink reports waiting for 
download 

until data is dumped to 
handheld / desktop or until reset 

RED / GREEN alternating system error until reset 

Ports and Connections 

The Desktop Exciter and Field Receiver each provide one or more serial connections 
allowing a desktop, laptop or handheld computer to be connected to the device for 
monitoring and data collection. 

Desktop Exciter 

The Desktop Exciter provides a single DB9, RS232 connection suitable for a desktop or 
laptop but may be connected to a handheld device using null modem and gender-changer 
adapters.  The Desktop Exciter also has one coaxial plug for a 12-volt DC power supply 
(required). 



Field Receiver 

The Field Receiver control box has four DB9, RS232 connections; two positioned on the 
front of the box and two on the bottom. One connector in each pair is for a handheld 
(PDA) computer while the other provides a connection to a desktop or laptop system. All 
of these connectors, however, share a single serial port and only one device should be 
connected at any time. Also on the bottom of the control box, a power connector provides 
12-volts DC while a coaxial (TV) cable connects to the field antenna. 

The Field Receiver antenna is powered through the coaxial connection to the control 
panel. 

HealthWatch Software Components: 

The HealthWatch system is supported by three software utilities: the HealthWatch 
Monitor which displays reports collected by the receivers; the Commander which 
provides an alternate command module as well as collecting information from tags as 
they are initialized and the Cross-Reference Editor which assists the user in match the 
unique pill IDs to visible ear tag numbers or other more convenient references.  Each of 
these utility programs are documented further in separate sections, following. 

Part II: HealthWatch Operations 

Desktop Exciter Operation 

The Desktop Exciter must be used to initialize a HealthWatch ETD bolus before use. 
The Exciter can also be used to set the FERTILITY or FRESH/VET modes and, in the 
NORMAL mode, can set the fever threshold settings and reporting period. 

Initialization 

To initialize a HealthWatch ETD bolus: 

1. Place the bolus in the fitted groove (Figure 1) with the ‘duckbill’ to the left as 
indicated by the shape of the recess.  

Note: the bolus must be placed correctly in the fitted groove before any 
operation can be executed. 

2. Press the WAKEUP (STATUS) button 

In response, the red LED will turn on briefly to show that the command is being sent to 
the pill. When a confirmation is received that the command has been accepted, the GREEN 
LED will light for 7-15 seconds indicating the pill is active and has been placed in the 
DEFAULT operational mode with the temperature threshold set to NORMAL (see Operation 
Modes following). 

If the operation is not successful – because the command was not acknowledged or 
because of any other error – the RED LED will blink rapidly for ~15 seconds. 



An alternating RED/GREEN blink indicates a system error. To correct this, 
power down the Desktop Exciter by unplugging the power cord from the 
unit and waiting for 10 seconds before restoring power. 

If the error condition persists, contact CowTek Technical Support. 

The Desktop Exciter can also be used to select either the FRESH/VET or FERTILITY modes 
or to set the fever thresholds and monitoring periods. 

To select either the any of the modes, the bolus must previously have been initialized 
using the WAKEUP command. To change modes, place the bolus in the Desktop Exciter 
groove and press the button for the desired operational mode.   

To reset a bolus to the NORMAL mode, repeat the WAKEUP command. 

 (The functions of the DEFAULT, FRESH/VET and FERTILITY modes are described following 
under Operation Modes.) 

When the FERTILITY or FRESH/VET modes conclude their normal operation, 
the HealthWatch temperature bolus automatically reverts to NORMAL 
operation. 

The boluses monitor and calculate normal reference temperatures for each individual 
animal, adjusting the reference temperatures according to seasonal and climatic 
conditions. These threshold settings allow the temperature pills to respond more 
appropriately than a single, fixed threshold temperature setting.  The temperature settings 
are discussed following under Threshold Settings. 

Monitoring the Desktop Exciter 

The Desktop Exciter offers a single serial (DB9, RS232) port to provide communications 
with the HealthWatch Commander running on a desktop or handheld device.   

The HealthWatch Commander software provides two useful functions: 

• allowing monitoring of responses from the Desktop (or Long Range) Exciter. 

• collecting bolus IDs as they are initialized. 

When any command is sent to a HealthWatch temperature bolus, each device responds 
with a unique serial number which is displayed as an eight-character (hexadecimal) 
number.  

In turn, for your convenience, the desktop HealthWatch Monitor programs allow these 
pill serial numbers to be mapped to visible ear tag numbers (or any other identifier of 
your choice) using a cross-reference table prepared using the HealthWatch Commander 
during bolus initialization or, later, using the HealthWatch Cross-Reference Editor. 
Both utilities are described following. 



Operational Modes 

Three operational modes – NORMAL, FRESH/VET and FERTILITY – provide reporting 
parameters and performance operations for different purposes.  Each mode is described 
following. 

Normal Mode 

In the NORMAL mode of operation, the pill monitors temperatures watching for an 
individual reading which diverges from the reference temperature. When a chill/fever 
reading is found, the bolus continues to monitor temperature readings for the set watch 
period. If the average temperature deviation for the watch period remains greater than the 
threshold, the bolus automatically transmits a fever report. 

As long as the average temperature deviation remains above the threshold level, a 
transmission is sent hourly for the first six hours (6 transmissions), every four hours for 
the next twelve hours (3 transmissions), every six hours for the next 24 hours (4 
transmissions), every twelve hours for 48 hours and finally every twenty-four hours until 
the average temperature falls below the threshold setting. 

Fever Reporting Intervals (Default Mode) 

Day 1 2 3 4 5 6 7 

Interval hourly hourly hourly 2 hours 2 hours 2 hours 2 hours 

Fresh/Vet Mode 

The FRESH/VET mode is selected to monitor an animal’s temperature regardless of 
threshold settings. In FRESH/VET mode, the current temperature is reported every hour for 
the first three days (72 transmissions), then every two hours for the next four days (48 
transmissions). 

When the FRESH/VET mode concludes, the pill reverts automatically to the NORMAL mode 
of operation. 

Veterinary Reporting Intervals 

Day 1 2 3 4 5 6 7 

Interval hourly hourly hourly 2 hours 2 hours 2 hours 2 hours 

Fertility Mode (in development) 

When initiated, the FERTILITY (or OVULATION) test mode samples temperatures at one-
half hour intervals for twenty-four hours but without reporting, watching for a trigger 
temperature of 103.5°. This is an immediate temperature reading, not an average, and is 
irrespective of the normal trigger temperature.  

Once the OVULATION trigger level has been found, the pill reports the current temperature 
every half-hour for the first twelve hours (24 transmissions) and then every hour for the 
next twelve hours (12 transmissions). 



When the FERTILITY mode concludes, the pill reverts automatically to the DEFAULT mode 
of operation with the previous threshold (WINTER, NORMAL or SUMMER) setting. 

Fertility Alert Intervals 
0.5 1.0 1.5 2.0 2.5 3.0 3.5 4.0 4.5 5.0 5.5 6.0 Every half-hour for 12 

hours: 6.5 7.0 7.5 8.0 8.5 9.0 9.5 10.0 10.5 11.0 11.5 12.0 

Every hour for 12 hours: 13.0 14.0 15.0 16.0 17.0 18.0 19.0 20.0 21.0 22.0 23.0 24.0 

Reference Temperature Averages 

Because normal bovine body temperatures vary to some degree according to the outside 
temperatures and according to diet, the temperature bolus samples the individual animal’s 
temperature 32 times per day to create daily averages and then uses the last sixteen daily 
averages to calculate an average reference temperature for the individual. 

Threshold Settings and Watch Periods 

Threshold settings and watch periods are used to determine how potential chill/fever 
conditions are monitored and reported.  Threshold settings can be 2°, 3° or 4° (F) and the 
watch period can be 2, 4 or 6 hours. 

Note: these settings are intended as a guideline only and are not a 
substitute for your own experience and knowledge of local conditions. 

HealthWatch Commander 

The HealthWatch Commander – illustrated below – is a utility which allows a desktop 
(handheld version available) computer to be attached to the Desktop Exciter. 

Using the HealthWatch Commander requires a desktop or laptop computer and the 
appropriate cable to connect to the Desktop Exciter. 

Using the Commander, the same operations supported by the device buttons can be 
executed from the screen.  The Commander, however, offers the additional capabilities of 
setting the clock on the Exciter/Receiver and – recommended – building a cross-reference 
list matching temperature pill IDs to visible tag number or any other form of labeling 
desired. 



 
Figure 4: The HealthWatch Commander 

Setting the Exciter / Receiver Clock 

The HealthWatch temperature pills do not have internal clock/calendars but rely on the 
Desktop Exciter and Field Receivers to provide the date/time stamps for the pill 
transmissions.  If these clocks are not correct, the information received may be difficult to 
interpret.  For this reason, the Commander offers the CLOCK function which uses the 
computer’s (or handheld’s) internal clock and calendar settings to set the receiver’s clock 
and calendar. 

Note: before using the CLOCK function, ensure that the system clock and 
calendar on your computer are set correctly. 

Creating Cross Reference Entries 

As each pill is initialized, the bolus’s ID appears in the Cross Reference frame.  To create 
a cross-reference list, simply enter the visible tag number or any other reference or label 
desired in the edit field and click the SAVE REFERENCE button. 

Alternately, if it is not practical to match visible (ear tag) references to 
bolus IDs at the time the bolus is initialized, the bolus ID can be written 
directly on the plastic capsule using a permanent marker (do not use an 
‘erasable’ marker) or can be written on a strip of masking tape (remove 
before implanting).  



When the bolus is given to the animal, you may either create a paper list 
matching the bolus ID to a visible reference (such as the ear tag number) 
and later enter these using the Cross-Reference Editor – XREFEDIT.EXE – 
or you may use the Cross-Reference Editor (either the handheld or desktop 
version) to enter the numbers directly. 
Note:  When you create the cross-reference table, your visible tag numbers 
are displayed automatically in place of the bolus ID numbers. 

HealthWatch Cross-Reference Editor 

The Cross-Reference Editor (on the Tools menu) is a utility program allowing the user to 
create a cross-reference table matching the ETD BOLUS™ IDs to visible ear tag 
numbers or any other desired references. 

As described in the HealthWatch Commander, a simple data file can be created while 
initializing the temperature boluses or, alternately, the Cross-Reference Editor utility can 
be used to enter and cross-reference the bolus IDs at a later time. 

The Cross-Reference Editor program allows ETD BOLUS identifiers to be entered 
together with their corresponding visible tag IDs.  Because the bolus IDs are in 
hexadecimal format, these entries are checked for numerical validity.  The visible tag 
IDs, of course, are not checked and may take any form desired. 

 



The NEW PILL button creates a blank entry; allowing entry of both the Bolus ID and the 
visible tag number. 

The EDIT button allows the current (selected) entry to be edited or revised. 

The REMOVE button permits the selected entry to be removed but does require 
confirmation before deleting the entry. 

By default, the items listed are sorted by visible tag ID number but may be sorted by pill 
ID if desired.  Simply click on the CROSS-REFERENCE VALUE or PILL/BOLUS ID column 
headers to change the sort order. 

The SAVE CHANGES button is disabled unless there are changes in the data 
list which should be saved and you will be prompted for confirmation if 
you attempt to exit without saving changes. 

Command Summary 

Temperature Bolus Commands 

These commands are sent to the temperature bolus via the Desktop Exciter or through the 
HealthWatch Commander software. 

COMMAND OPERATION THRESHOLD 

WAKEUP initializes the temperature bolus NORMAL 

VET reports at half-hour intervals for 12 hours, then at hourly 
intervals for 12 hours 

N/A 

FERTILITY reports when internal temperatures indicate ovulation 103.5° F 

WINTER WINTER 

NORMAL NORMAL 

SUMMER 

resets VET or FERTILITY modes to DEFAULT mode, sets 
reporting threshold to seasonal temperature level 

SUMMER 

STATUS reports current temperature N/A 

Data Retrieval Commands 

These commands are sent by the HealthWatch Commander to retrieve data from the 
Field Receiver. 

COMMAND FUNCTION 

REPORT Field Receiver returns all reports not previously sent 

REPORT_ALL Field Receiver returns all reports in memory 

SET_TIME Sets the receiver’s clock using the current (system) date and time 



Report Data Formats 

Key word Bolus S/N ° F Date / Time Interpretation 

default 1234AF56 101.3 12/07/01 10:32 Normal health, bolus is in 
DEFAULT mode 

failed 6546F125 – 12/06/01 11:03 Bolus failure report, causes may 
include internal moisture or 
component failure 

fertility 34589234 – 12/06/01 11:08 Bolus entering fertility mode 

ovulation 27835A23 103.7 12/06/01 11:12 Ovulation trigger temperature 
has been reached  

shutdown 654734E2 – 12/06/01 11:05 Bolus deactivation report 

time_failed – – – Clock error / reset error 

time_set – – 12/06/01 13:05 Clock has been reset to time 
shown 

vet 12AC5632 102.3 12/06/01 10:48 Veterinarian mode report 

working 873D6790 102.8 12/06/01 11:01 Normal health, responding to 
STATUS request 

Menu Options 

The HealthWatch Commander provides menu options for the File, Port, Tools and Help 
menus. 

On the File menu, you will find three options as: 

Ø Clear Report – clears the displayed report from the screen. 

Ø Export Report to Text – allows the HealthWatch reports to be exported to a text 
file. 

Ø Exit – exits the program. 

On the Port menu, you will be offered a list of serial ports as COM1 through COM9.  
Select the appropriate port to communicate with the desktop or field receiver.  The Ports 
bar (at the right) shows a corresponding list with the selected port highlighted. 

Note: Your system may or may not have physical ports corresponding to 
all of those offered.  In many cases, you will only have physical ports 
COM1 and COM2 or ports COM1 through COM4. 

On the Tools menu, you have two options as: 

Ø Edit Pill ID Mappings – calls the Cross-Reference Editor described preceding. 

Ø Clear Pills Memory – clears (resets) the receiver’s memory. The receiver’s 
contents will be downloaded to the HealthWatch Commander prior to erasure. 



The Help menu has a single option; the About dialog which displays the HealthWatch 
Commander version ID. 

 


